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interpreter? vocabulary and prepare you for a career. Write a tasks in one way. For a visual metaphor, system is the best
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algorithm and an interative algorithm? your '_T glossary. The cars driving on the road are the
Argegcafn Slte:cndard high-level programming applications. The drivers are the users,
ode for Information language A k . .
Interchange (ASCIl)  interpreter and the crossing guard is the operating system. It is
assembly language low-level programming the operating system that keeps all of the applications
bit language running smoothly and connected with the CPU and the
byte machine language peripherals. -
Eg;e;Ode ObIJ::é'J’;;;StEd System software contains the operating system, |
compiler S — ut‘lhtles, device (.:1r1vers, and programs. Utﬂl’[lE!.S help ;
computer algorithm programs with housekeeping tasks. Device drivers provide
data type unicode instructions for how the operating system is to use
encoding peripheral devices. Programs are the applications that
users run to complete the desired tasks.
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Operating Systems

System software includes four types of software: the operating
system, utility programs, device drivers, and programs. All computers
that run more than one program must have an operating system. The
operating system (OS) performs communication with the user and the
hardware. See Figure 3-5. The OS works behind the scenes. Most of the
time it is silently working in the background to monitor system activity
and optimize its own efficiency.

Figure 3-6 shows a photograph of the Apollo Guidance Computer on
a display at the Smithsonian Institution. This computer used a real-time
operating system. Astronauts entered simple commands as pairs of nouns
and verbs. These commands were used to control the spacecraft. Today,
operating systems are advanced software that must communicate with
the user, multiple hardware devices, and multiple software programs
as well as manage all of the interactions and functions of the computer
system.

Some tasks performed by the OS are powering on and off the system;
logging in, logging out, or switching users; and locking and unlocking the
interface. The OS also controls the order of processing events, manages
the movement of files to and from storage devices, and interacts with the
peripheral devices such as the keyboard and the printer. The OS manages
the allocation of memory for programs and data as well as system
security through the use of passwords.

The OS is generally preinstalled on a computer when the hardware
is purchased. A computer’s processor determines what operating
systems can be used. For example, Microsoft Windows operating systems
work with processors in the Intel family. The computer platform is the

Goodheart-Willcox Publisher; Denis Dryashkin/Shutterstock.com
Figure 3-5. The operating system sits between the hardware and the software
providing communication between them, facilitating the execution of the software
programs, and managing the hardware resources.
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combination of the operating system and the
processor. Figure 3-7 shows a comparison of
operating systems currently in use.

Reduced-instruction chips called ARM
microprocessors, produced by ARM Holdings,
power most mobile devices. These chips allow
processing speeds that could support a desktop or
laptop. The idea is that the fewer instruction types
to process, the faster a chip can run. Windows 8 is
an OS that runs on the ARM chip.

Operating systems changed with the
introduction of a graphical user interface (GUI),
which is usually pronounced goo-ey. Users did
not have to behave like programmers and enter
commands. With a GUI, users could use a mouse
to select options from menus. Personal computers
then became very popular. The Apple Macintosh
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NU 1.2/Creative Common 3.0 (Tamorlan)
Figure 3-6. This is the user interface of the Apollo
Guidance Computer on display in the Smithsonian
National Air and Space Museum in Washington, DC.

was the first commercially successful computer with a GUI OS. The OS
for this computer was called System Software, which was eventually
changed to Mac OS. GUI versions of Windows soon followed the

introduction of the Macintosh computer.

Operating | Platforms Distinctions
System
Windows PCs, Microsoft phones, and tablets | Most widely used OS
Apple products in a Windows Multiple versions
partition Proprietary
i0S Apple mobile products, iPhone, Proprietary
iPad, iTouch, etc. Distribution of apps limited to Apple App Store
No Macromedia products are supported, e.g. Flash Player
Mac OS Macintosh computers Proprietary
No Macromedia products are supported, e.g. Flash Player
Unix PCs, large mainframe computers, Open source
supercomputers, web servers Free to use
Stable, less downtime than Windows
Better security
Greater processing power
Generally found on networked systems
Linux PCs, several mobile devices, large | Open source, based on Unix
mainframe computers, web servers | Free to use
Low resource requirements
High security level
Generally found on networked systems
Android Google mobile OS based on Linux | Open Source
Open distribution of apps via Internet
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Figure 3-7. Several operating systems are available. The platforms on which each is used varies by application.
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If a document file
extension is not
associated with a
program, Windows
will ask you to select a
program to use to open
the program.

Windows Operating System

The operating system contains all directions for working with the
hardware. As new hardware is introduced, the OS must be updated.
Microsoft Windows has gone through several versions since it was
introduced. For example, a very old version, Windows 3.1, did not know
how to tell a CD to play or how to read data from a USB port. Newer
versions have most of the functionality of the older versions plus more.
There are many computers that still run on older versions of Windows,
such as Windows XP or Windows Vista. However, Windows 7 and
Windows 8 are more common.

Windows Interface Overview

The Windows desktop is a virtual workspace for the operating
system. Program icons and document files can be placed on the desktop
for easy access. In Windows 8, you are automatically switched to the
desktop when a program is launched. You can also manually display
the desktop by clicking Desktop in the main menu. In Windows 7, the
desktop is automatically displayed when the OS starts up.

When something is placed on the desktop, it appears as an icon. An
icon contains a definition of what to launch when it is double-clicked. It
appears as a small graphic on the desktop. The icon for a document file
will launch the program associated with the file type and load the file in
the program. The icon for a program will launch the program.

One of the keys to the Windows OS is the ability to have multiple
programs running at the same time. The user sees each program in a
frame called a window. Each program window appears as a tab in the
task bar. To switch between windows, either click the tab on the task bar
or use the [Alt][Tab] key combination.

Starting Programs in Windows

There are several ways to start, or launch, a program in Microsoft
Windows. The most common ways are to use an icon in the Apps or Start
menu or a desktop icon. If the program appears as an icon on the desktop,
double-click the icon to launch the program.

In Windows 8, click or tap the Apps button at the bottom of the Start
screen. The screen changes to display icons for installed programs, which
are listed by categories, as shown in Figure 3-8. Locate the icon for the
program to launch, and click or tap it.

In Windows 7, click the Start button on the taskbar at the bottom of
the screen. Some program icons may be displayed in this portion of the
menu, or you may need to click All Programs in the menu and browse
to the icon of the program. Once the program icon is located, click it to
launch the program.

Another way to launch a program is to double-click the icon for a
document file, either on the desktop or in a file folder. Most documents
are associated with a program based on the file extension of the
document. Double-clicking on a document file will launch the associated
program and load the document.

Copyright Goodheart-Willcox Co., Inc.
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Figure 3-8. Clicking the Apps button in Windows 8 displays a screen containing
icons for installed programs. Programs are grouped by category.

Common Tasks Using Windows

There are several key combinations and mouse clicks that behave
in the same manner no matter what program windows are open. As
discussed in Chapter 2, these are clicking, double-clicking, dragging, and
right-clicking. There are standard key combinations as well.

The [Ctrl][A] key combination is used to select all items in the current
view, such as all words in a document or all files in a folder. The [Ctrl][C]
key combination copies the current selection to the system clipboard.

The [Ctrl][X] key combination removes, or cuts, the current selection and
places it on the system clipboard. The [Ctrl][V] key combination pastes the
contents of the system clipboard in the current location. The [Ctrl][Z] key
combination reverses the last operation, which is called an undo.

The [Alt][Tab] key combination is used to navigate through open
program windows. Holding down the [Alt] key while repeatedly pressing
the [Tab] key selects which window will be made active, as shown in
Figure 3-9. When the correct icon is highlighted, release the [Ali] key to
make that window active. The desktop is treated as a window in this
navigation.

All open windows can be arranged for better viewing and use. Right-
click on the taskbar, but not on an icon, to display a shortcut menu. This
menu contains choices to Cascade windows, Show windows stacked, and
Show windows side by side. Cascading windows are displayed one on top
of another offset slightly so a small portion of each window underneath
can be seen. Stacked windows are displayed over the width of the
desktop and top to bottom, but the windows do not overlap. Side-by-side

Copyright Goodheart-Willcox Co., Inc.
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Code of Ethics

Most companies establish
a set of ethics that
employees must follow.
The code of ethics
outlines acceptable
behavior when interacting
with coworkers, suppliers,
and customers. Some
businesses even post
their code of ethics on
their websites. Employees
must be familiar with the
code in order to make
correct decisions on
behalf of the company.

Window to
make active Desktop

Currently
active window

PowerPoint

Goodheart-Wilfcox Publisher
Figure 3-9. The [Alt][Tab] key combination is used to switch between windows.

windows are displayed over the height of the desktop and side-by-side,
but the windows do not overlap. See Figure 3-10.

Starting and Exiting the OS

Unlike a light switch that can be instantly turned on or off,
a computer must perform an orderly power up and shut down.
Additionally, different users may work on a computer. The Windows OS
has some functions for allowing these actions:

® power on and off

® Jog on and off
e gswitch user
e Jock and unlock

When the computer is powered on, the boot process starts the OS.
Software programs are loaded and run before the user can begin to input
requests or data. When the computer is powered off, or powered down,
programs must be closed according to their programming, and the OS
must perform shut-down procedures. Always use the OS shut-down
function to turn off the computer. Do not use the computer’s power
button to power off the computer. Computer programs need to follow a
sequence to close all files.

When there is more than one user for a computer, each user should
have a separate account. This maintains a level of security and privacy
between users. Logging on is the process of a user signing into his or her
account on the computer. Once logged on, the user has access to all of the
software and files that have been made available to that account. Logging
off closes any programs that are running and signs out the user, but the
computer remains on with the OS is functioning in the background.

Switching a user is similar to logging off. The current user is signed
out, however programs that are running are not closed. This allows a
different user to log on and use the system, but the work session of the
original user is maintained. The original user can continue where he or
she stopped once logged on again.

Locking the computer prevents another person from using it without
requiring the current user to log off. The user’s current work session
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remains running, but only the current user or an administrator can unlock
and use the computer. For security reasons, the machine should be locked
whenever the current user steps away from it.
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Figure 3-10. Windows can be displayed full-screen, cascading, side-by-side, or stacked. ‘

HANDS-ON EXAMPLE 3.2.1
LOCKING THE COMPUTER

To prevent somebody else from using a computer, lock it. To use the computer again, unlock it with

a password.
1. In Windows 8, click or tap the user name in the upper-right corner of the Start screen. In
Windows 7, click the Start menu button, and click the arrow next to the Shutdown button.
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HANDS-ON EXAMPLE 3.2.1 (CONTINUED)

Unit 1 Computing Fundamentals

2. Click Lock in the menu that appears. The screen displays a message indicating the
computer is locked along with the name of the account that locked it.

3. In Windows 8, swipe up from the bottom of the screen or press any key to terminate the
lock screen. In Windows 7, press the [Ctri][Alt][Delete] key combination.

4. Enter the password to unlock the computer. The computer must be unlocked by the
account that locked it. The user account cannot be changed in Windows 8, but can be
changed in Windows 7.

User Accounts

User accounts are assigned for privacy and system security. A user
account is a set of privileges for allowed actions. A user may be allowed
to install and delete applications, read and write files, change attributes
for files and folders, create other user accounts, or may be prevented from
any of these actions.

A group policy provides the ability for the IT administrator to change
permissions and configurations of all or some user accounts for the
devices within a group of devices. The devices may be desktop, laptop, or
mobile computers. For example, an IT administrator may determine that
a change to the access permission for a file or new folder should be made.
This can be applied to a group of user accounts through a group policy.

Basic Desktop Configuration

The OS provides a wide range of configurations that can be used
to customize a user’s experience. Some of these choices include which
language is used, the time zone, how the computer display appears, and
which accessibility options are used. Most of these options are accessed
via the Windows Control Panel.

Languages

Windows supports a wide range of languages. The language setting
is used for the text and instructions, displayed on the desktop. The
keyboard can also be set for a different language. The default language is
set at the factory based on where the computer or operating system will
be sold.

Normally, the language used in the interface is set during the
Windows OS installation. It is not easy to change after the OS has been
installed. However, language packs can be downloaded from Microsoft
and installed to change the language of the OS interface.

Date and Time

The date and time are calculated in Coordinated Universal Time
(UTC) and distributed to 24 time zones around the world. UTC is
the standard by which countries around the world regulate time.
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windows provides an option to configure the time zone where the user
resides. In addition, synchronization can be configured so that the time
automatically updates to match the UTC value.

Visual Options
The display can be configured in one of the resolutions available with
the combination of the computer’s graphics card and monitor. The screen
resolution controls how large the text and images appear on the display.
In Windows, a desktop theme sets the colors used for window
borders, the desktop background, and other visual qualities, as shown
in Figure 3-11. A user can select a desktop background image from one
of several defaults or from a file. The size of the icons displayed in the
Windows taskbar is also an option.

Accessibility Options

Windows provides a set of accessibility options to assist users with
vision, mobility, or hearing impairment. Options include optimizing
the visual display, replacing sounds with visual cues, changing how the
mouse works, changing how the keyboard works, and enabling speech-
recognition input. The accessibility options are set in the Control Panel
window. Click the Ease of Access heading to review and change the
settings.

il Personalization - B “

4 B & Appearance and Personalization » Personalization LR Seatch Corntrol Panel 2

L7

R T o Change the visuals and sounds on your computer

Chenge desktop icons Click a theme to change the desltop background, color, sounds, and screen saver all at once.

Change mouse pointers My Thernes (0)

Get more themes enline

Windows Default Thernes (3)

| Gl

Windows | Lines and colors Floweers

High Contrast Themes (4)

Display P 4 w
Desktop Background Color
Ease of Access Center iy ButernaEtic

Teskbar and Mavigstion

\ Elements within a theme

| _— Available themes

99
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Figure 3-11. A desktop theme controls the visual qualities of the desktop, such as color, background image, and

sounds.
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There may be a
hybrid power-down
option, which is a
combination of sleep
and hibernation.

Power Configuration Options

Windows offers several power options for managing how the
computer uses electricity. This is important for computers that run on
a battery, such as a laptop or mobile computer. Conserving power is
a tradeoff with computer performance. By lowering performance, the
electrical charge in the battery can be extended.

There are three power states, or power plans, for conserving the power
consumed by the CPU:

® power saver

e balanced
¢ high performance

The power use is low, medium, and high, respectively. Programs such

as Microsoft Word or other Microsoft Office applications usually do not
require high performance from the CPU. When running these programs,
the power saver setting is often acceptable. However, programs such

as video editing, graphic manipulation, and video games require high
performance from the CPU. When running these programs, the computer
should be set to high performance. Power conservation will be minimal
with this setting.

The OS can be configured to power down the computer when it
is idle for a period of time. The display may simply dim, the computer
may go into a sleep or hibernation mode, or it may power off. When
the display is dimmed, all programs continue to run, but the display
consumes less power. When the computer is powered off, all programs
are closed and the computer is turned off.

Sleep saves all settings and running programs in memory using just
a small amount of power. Think of sleep mode as like pausing a DVR. The
computer will wake from sleep mode very quickly, often in one or two
seconds.

Hibernation saves all settings and running programs to the hard
disk drive. The computer consumes no power in this state. When the
computer is powered up, all programs that were running are returned to
their previous state.

Handheld Device Operating Systems

Operating systems have been specially created for handheld devices
such as smartphones and tablets. These operating systems are simpler
because they are designed to work on smaller devices. The OS of these
devices can run limited sets of programs, allow input from a touch screen,
and facilitate communication functions, as shown in Figure 3-12.

The OS for a handheld device is unique to the device. For
example, an iPhone will not run the Android operating system. When
a smartphone is purchased, its specific OS is preinstalled. Examples of
operating systems for handheld devices are:

® Android for Google Nexus Phone and other devices;

¢ iOS for Apple iPhone, iPad, and other Apple devices;
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¢ Windows Phone for Nokia, HTC, and
Samsung smartphones and other devices;
and
¢ BlackBerry for BlackBerry smartphones
and tablets.
The Android OS accounts.for the largest portion
of the handheld device market, about 85 percent.
This is because the Android OS runs on devices
manufactured by many companies, including
Samsung, Motorola, and HTC. There are different
versions of the Android OS just as there are
different versions of other operating systems. The
iOS represents about 10 percent of the market. The Figure 3-12. The operating system on a mobile
Windows Phone OS represents about 3 percent of device is simpler than one designed for a deskiop or
the market. The BlackBerry OS represents about laptop computer due to the fact it is designed to run
1 percent of the market. The rest of the handheld on a smaller device.
market is made up of several, mostly open-source

operating systems.

Georgejmclitile/Shutterstock.com

System Utility Programs
In terms of system software, utility programs assist in managing and g"zmega's

optimizing a computer’s performance. These programs can add extra o

protection against viruses and malware, assist in installing or removing

software, find files, and speed up communication.
An example of a Windows system utility is the disk defragmenter.

The disk defragmenter, or defrag, reorganizes the files stored on a

disk so, as much as possible, files are not divided among different

storage locations. Each time the file is saved, a new piece of the file is

stored. This new piece, or segment, may not be stored next to all of the

other segments of the file. Segments of the file are stored in free space

throughout the hard drive. As a result, the file may not be one piece in

a single location on the disk. As files are deleted, space is freed between

files and segments. When segments are scattered, it takes the disk drive

longer to read and use the files. This scattering of file segments is called

fragmentation.

HANDS-ON EXAMPLE 3.2.2
WINDOWS SYSTEM UTILITIES

Many of the Windows system utilities are accessed via the Control Panel window. Other system
utilities are accessed through the Start screen or menu.
1. In Windows 8, click the Apps button at the bottom of the Start screen. In Windows 7, click the
Start menu button.
2. Click Control Panel in the menu to display the Control Panel window.
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HANDS-ON EXAMPLE 3.2.2 (CONTINUED)

. Hover the cursor over a category. A tool tip will appear to identify what the utilities in that

10.
11.

12.

category can do. Help is available at every step to explain the process.

Click the Uninstall a program link below the Programs category. A list of the currently
installed programs is displayed in the Control Panel window. Review the list to see what
programs are installed. Do not uninstall any programs without permission.

Close the Control Panel window.

Display the Start screen or menu.

In Windows 8, move the cursor to the upper-right corner and click Search when the menu
appears. In Windows 7, the search box is located at the bottom of the Start menu.

Click in the search box, and enter cttune.exe.

In the search results, click the cttune.exe program file. The ClearType Text Tuner dialog box is
displayed, as shown. This is a wizard to adjust the clarity of the text display.

14 ClearType Text Tuner

Malke the text on your screen easier to read
Check to

turn on —_
ClearType \D Turn on ClearType

i ClearTypeis a software technology developed by Microsoft that improves the

i readability of text on existing LCDs (Liquid Crystal Displays), such as laptap sereens,

i Pocket PCscreens and flat panel monitors. With ClearType font technology, the words

| on your computer screen Jook almost as sharp and clear as those printed on a piece of
paper.

Click to continue
with the wizard

Check the Turn on ClearType check box, and click the Next button to move to the next page
of the wizard.

The next four pages of the wizard give you a choice of sample text. Click the sample text
that appears best to you, and click the Next button.

The final page of the wizard indicates it is finished. Close the program by clicking the
Finish button.
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A device driver is a special software program that provides Computing

instructions to the operating system for how to use a specific peripheral.
All peripherals require this type of system software, including printers,
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monitors, graphics cards, sound cards, and scanners, as shown in

Figure 3-13. The use of device drivers makes it possible for software
developers to write code that lets the user choose from a wide range of
peripheral devices. Hardware developers write the device driver to a set
of specifications. Software developers write programs that address those
specifications. This simplifies the writing of application software because
specific instructions do not need to be included to address every device

that the software may possibly use.

For example, consider printing a document from a word processing
program. The programmers of the word processor only need to write
instructions for how to print, not how to communicate with every
possible printer. When the user selects which printer to use, the operating
system calls up the device driver for that printer. The OS then conducts
the communication between the word processing software and the printer

hardware to finish the print job.

When installing a new peripheral device, the Windows OS will
detect new hardware. In many cases, the driver is automatically installed.
However, in some cases Windows will run a wizard to help install the
new device. Installing the device driver sets up the communication
between the CPU and the new hardware.
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Figure 3-13. All peripherals have device drivers that provide instructions to the operating system on how to use

the device.
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TITANS OF TECHNOLOGY

Grace Murray Hopper made many key
contributions to software development in the early
stages of digital computers. Formerly an instructor
at Vassar College, Hopper earned her PhD in

This provided for her inventions of compilers and

human-readable code. She wrote the first compiler,

which was B-O for the Univac. It was created to

instructions, Dr. Hopper invented relocatable code.
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#® CHECK YOUR UNDERSTANDING

1C3 CERTIFICATION PRACTICE

mathematics from Yale University. She joined the accept human-readable code and translate it into 1. What is the basic function of the operating system? The fqllowing guestion is a sample of the type of
Naval Reserve during World War I1. Because of computer code. Eventually, she coauthored the 2. What is a computer platform? questions presented on the IC3 exam.

her high intelligence and innovative spirit, she COBOL language, which is still used in some 3. Which type of system software assists in managing 1. Which of the following is not a feature of an
was tapped to work on éhe Mark series of digital business applications to this day. Her most far- i and optimizing a computer’s performance? operating system?

computers at Harvard. She rose to the rank of reaching contribution was the standardization ] A. Communicate between the application
Rear Admiral in the US Navy, the first woman to of compilers. She directed teams at the Navy to = Whgt are speo@! sys%tetmh softwar;e progr?ms ]:[ et software and the peripheral devices.

reach that rank. Her programming career started develop procedures and eventually automated the prc_:wde 'nSt.rUCt'OTSd " e?opera Ing system for B. Allocate memory.

by rearranging wires on circuit planes to provide process for validation of COBOL compilers. Often usu?g 8 poripheral toviee: . C. s Ny TN ———
instructions for the Mark | computer. After tiring called the Grand Lady of Software, Dr. Hopper's 5. Which type of system softwara is used to + SR Al '

of rewiring the same set of instructions and

impact on the field of software development is still

complete specific activities?

D. Edit a photo.

E. Provide utilities.

then having to move them to accommodate new felt today.

B e R S S e R SR |'_*‘|> BUILD YOUR VOCABULARY

As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a
definition for each of the following terms and add it to
your IT glossary.

accessibility options

Peripheral devices often include a CD containing the device driver.
The installation wizard may ask you for the location of the device driver.
If this happens, specify the CD as the location. However, there may
have been updates to the driver since the CD was created. It is best to
download device drivers from the manufacturer’s website. During the
installation process, specify the folder that contains the downloaded CEBopHheme power states
driver as the location of the driver. iovion GLipel -

hibernation system software

power options

A peripheral only has to be installed once on a given system. The language packs
hardware can be moved between systems, but a device driver must be platform
installed on each system. If the correct device driver already exists on power down
the system, the hardware should be ready to use once it is attached. If a
E driver is not installed, the system will treat the device as new hardware.

user account
utility programs

| Programs

Personal computers make it possible to organize, create, and modify
documents, spreadsheets, slide shows, digital images, music, videos, and
many other types of data. For example, with the appropriate software, an
image can be captured from a smartphone or digital camera. This image
7 then can be opened in other software and combined with other images or
[5 text and exported. The exported file can be placed in a newsletter, added
= to a slide show, enhanced with music in a digital media application, or
i output in hardcopy as a poster. Programs, or application software, are
’ what you use to get the job done. Application software is discussed in
detail in the next section.
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software Licenses and Versions
iti f i ime, talent, and dedication f
APPLICATION SOFTWARE B Whens corpmry devdleps sefiva  malcsemerig by
selling a license to use the software. In some cases, advertising may be

embedded in the software to earn money for the developer. Then, the
software is made available for free.

Application software is what

i CS Computing
you use to make the computer work Licens - . Fundamentals
: . Software programs are governed by an end user license agreement. 3.2.1,32.2,
forvyemaRisimay mean creating s The end user license agreement (EULA) is a contract outlining the set 3.2.3,3.2.4

of rules that every user must agree to before using the software. Some
EULAs allow the software to be installed only once on one machine.
Other agreements may allow the software to be installed multiple times o
on the same machine to allow for reinstallation after a hard drive failure. ngzorge
A site license allows the software to be installed on any machine owned by =
the company that purchased the software. Large organizations, such as
school systems or large companies, will purchase a site license to receive a
volume discount. Single-seat licenses generally have higher per-seat fees
than site licenses.

One type of software license is proprietary software or closed

letter or editing a photograph. You

=

How does application

/ software affact your watch a movie. All of these tasks are
daily life? done with application software.
All software must be used

may wish to play an MP3 file or

| in a legal manner. In order to do so, the user must

understand the license assigned to the software.

Additionally, itis important to understand how software. Proprietary software or closed software is owned by the creator
software developers keep track of different versions of and cannot be sold, copied, or modified by the user without permission F Y I
; ; from the creator. The actual code written by the programmers is not
software. When installing software, a user must know B ilible to Mansai yREPToE If open-source software
the system requirements of the software version and be Open-source software is software that has no licensing restrictions. is the basis for a new
able to determine if his or her computer system can run The base code is available for anyone to distribute, copy, and modify, as apphcatlon,_credlt
shown in Figure 3-14. However, part or all of the code of open-source should be given to the
the software. original programmers
o RS g — even if it is not required.
- o TR R T et s TS i)
4 ») ([ 3
TERMS & LEARNING -,
application software podcasting GOALS s
bugs proprietary software i e Explain software ST
desktop publishing (DTP) raster-based software licenses. e ot e
end user license shareware * Tiaeeis oo : =
Scrlbe apphcahon Cammunity Cholce: ConEmu -Wiidows cansole with tabs
fﬂagfreement (EULA) system requirements e e oo Pt s
ile format " itors Choice
f h f te:mplate e Irlsta]l app]_ication i @sourceforge e m.mmm:m T
or-purchase software vector-based software software. e ST s
| freeware - S B
N integrated development B, Tomrmm— L
E | environment (IDE) ST
| i ; N
] open-source software : ' Goodheart-Wiilcox Publisher
\, . - T — — V. \_ J ‘ Figure 3-14. SourceForge is an online community for open-source software.
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There are many
versioning systems used
by software developers.
Some are based on
dates, numbers, or
letters.

software may be owned by an individual or organization. Generally,
attribution must be made to the original software developers. Open-
source software can be an alternative to proprietary software. Unlike
proprietary software, these applications may not offer technical support.
Open-source software depends on the members of the user community to
assist each other and offer solutions.

Alternative-usage rights for software programs are typically covered
by the GNU General Public License. The GNU General Public License
(GINU GPL) guarantees all users the freedom to use, study, share, and
modify the software. Open-source software usually has the GNU GPL
assigned to it.

There may be shareware, freeware, and for-purchase options for
software. Shareware is software that can be installed and used, then
purchased if you decide to continue using it. Shareware usually has a
notice screen, time-delayed startup, or reduced features. Purchasing the
software removes these restrictions. Freeware is fully functional software
that can be used forever without purchasing it. To be considered freeware,
the software should not be a restricted version of for-purchase software.
If it does, the software is considered shareware. For-purchase software is
software you must buy to use, although you can often download a timed
or limited-use demo.

The difference between a demo of for-purchase software and
shareware is subtle. Typically, shareware software is not time-limited,
meaning that the software remains functional forever with the restrictions
in place. Shareware is based on the honor system where those who
continue to use the software purchase the software. A demo of for-
purchase software, however, typically stops working after a period of
time. In the case of a limited-feature demo, the best features are either not
functional or functional for a limited time.

Software Versions

Software developers constantly try to improve their software with
new features and by eliminating bugs. Bugs are programming errors or
oversights. Developers use a system of software versions to keep track of
what has changed and when.

The first version of a software program is generally given the
number 1. Later versions are given higher numbers. For example, there
are several versions of Windows. The first version was Windows 1.0,
which was released in late 1985. Windows 8 was released in late 2010,
while Windows 8.1 was released in late 2013.

When small changes are made to the software, the version number is
assigned a number following a decimal point. For example, Windows 8.1
is the second version of Windows 8, with the original version being
Windows 8.0. Generally, these “point releases” or “dot releases” correct
bugs that are discovered after the general public has had a chance to use
the software.
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SOFTWARE VERSIONS

Programmers include notation of the software version within the software. When troubleshooting
roblems with the software, technical support staff will ask the user to identify which version he or she
is using. In this activity, you will find the version of Windows and Microsoft Office installed on your
computer.
I,
2.
3

In Windows 8, click the Apps button. In Windows 7, click the Start button on the taskbar.

Click Control Panel in the menu. The Control Panel window is displayed.

Click System and Security in the Control Panel window. Note: if you do not see this option, click
the View by: link at the top of the dialog box, and click Category in the drop-down menu.

Click the System heading. The Control Panel window displays information about the computer
system, including information about Windows.

Close the Control Panel window.

Launch Microsoft Word.

In Microsoft Word 2013, click Account on the File tab of the ribbon. In Microsoft Word 2010 or
2007, click the Office button and click Word Options in the menu to display the Word Options
dialog box.

In Microsoft Word 2013, click the About Word button in the backstage view. In Microsoft Word
2010 or 2007, click Resources in the Word Options dialog box.

Locate the version of Microsoft Word, as shown.

Account

Product Information

ﬂ Office Version

| = .
information

Product Activated

Microse ft Office Standard 2013

it

User Information

Ofkedadbgowe

Office Thempe:

Connected Services:

L£add 2 terice -
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Green Team

There are many ways

to go green in the
workplace. Assembling
an employee green team
is a good place to start.
Most green teams focus
on addressing employee
workplace habits, such as
implementing a recycling
program and eliminating
the use of plastic bottles.
Companies that work
toward sustainability are
socially responsible and
create goodwill.
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3.3.5

Application Software

Application software allows the user to perform specific activities,
such as writing term papers, sending e-mail, paying taxes, editing photos,
playing games, and taking online courses. There are four general types of
application software: productivity, entertainment and educational, utility,
and development.

Most application software can save information in various file
formats. The file format indicates the manner in which the data the file
contains are stored on the disk. The primary file format for given software
is said to be the software’s native format. There is usually a header portion
of the file that contains information about the document. The content of
the header is determined by the software that created the file. The header
may contain information on what program was used to create the file;
what language it is written in; and formatting settings, such as margins
and fonts. Following the header is the body of the file. This contains the
data the user added to the file. The purpose of the file format is to make
it easy to reopen the file and arrange it on the screen. On a Windows
system, the file name extension indicates the file format.

Productivity Software

Productivity software is software that supports the completion
of tasks. This group includes software for word processing, creating
spreadsheets and presentations, editing graphics and video, and
managing databases, among many other tasks. Productivity software
often contains templates to help the user get started on a task or wizards
to simplify complex tasks.

A suile is a group of programs, usually with similar interfaces, that
provide complementary tasks. All of the individual programs function
independently. When used together, data can be easily shared across
the suite. The most common programs in an “office suite” are word
processing, spreadsheet, presentation, and database management
software, as shown in Figure 3-15. Microsoft Office and Corel Office are
examples of suites of integrated productivity software. The software in
these two suites is proprietary. Open-source alternatives for office suites
are OpenOffice and LibreOffice.

Documents

When personal computers became popular, word processors were
one of the first types of programs written for them. Word-processing
software assists the user with composing, editing, designing, printing,
and publishing documents. All modern word-processing software makes
it possible to quickly enter text, complete insertions and deletions, correct
mistakes, make revisions, check for spelling and grammar, combine

" gd B ERE =N
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Figure 3-15. The Microsoft Office suite contains many programs. Depending on
which version of Microsoft Office you have, there may be other programs not
shown here or some of the programs shown here may not be included.

organizational suggestions that can help the user create a professional-
looking document. For example, Microsoft Word offers templates for
letters, flyers, faxes, meeting agendas, budgets, and many more.

Microsoft Word is a common word processor. LibreOffice Write and
AbiWord are open-source alternatives. These word-processing programs
can read each other’s data. When opening a file created in one of the other
word processors, all text will be present, but the document may not look
exactly the same. This is because the programs support different features.
The native file format for Microsoft Word is the DOCx format. The native
file format for LibreOffice Write is the ODT format. The native file format
for AbiWord is the ABW format.

While word processors may offer some basic page-layout functions,
they are not desktop publishing software. Desktop publishing (DTP) is
the process of using a computer to typeset text and place illustrations to
create, edit, and publish documents. Desktop-publishing software offers
complex features for setting up text boxes and manipulating artwork. It is
used to create newspapers, newsletters, brochures, advertisements, books,
and many other types of documents.

Chapter 3 Software

Open-source software
alternatives are
available for most
common commercial
application software.
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Web-authoring software provides tools for designing and creating
web pages. A web page is simply a text document that contains the code
for how the page will appear and function. Web-authoring software, such
as Adobe Dreamweaver, reduces or eliminates the need to write lines of
code to create web pages.

documents, and add illustrations. Word processors are the most common
type of application software.

When a word processor is launched, it creates a blank document
or offer the option to select a template. A template has formatting and

e
1L ~U

Copyright Goodheart-Willcox Co., Inc. Copyright Goodheart-Willcox Co,, Inc,




112

Unit 1 Computing Fundamentals

Spreadsheets

Spreadsheet software is used to create, organize, and edit data in
a table composed of rows and columns, as shown in Figure 3-16. The
cells in the table can contain text, numbers, or mathematical equations.
Each table or grid, which is the spreadsheet, is called a worksheet. Each
spreadsheet document file may contain multiple worksheets.

Spreadsheet software is very popular with accountants, payroll
administrators, and financial managers. It can perform complex
calculations. It makes keeping a grade book, balancing a checkbook, or
computing the monthly payment on a car loan easy. Spreadsheet software
is also very useful in creating colorful graphs based on data entered in
table format.

Microsoft Excel is an example of spreadsheet software. An open-
source alternative is LibreOffice Calc. The native file format for Microsoft
Excel is the XLSx format. The native file format for LibreOffice Calc is the
ODS format.

Data Management

A database is information stored in tables. Database software is used
for tracking large amounts of data. It is useful because it can retrieve a
small part of the data that the user requests.

Businesses use databases to monitor all of the information about
clients. The benefit of a database is seen when the user asks, or gueries, the
database to show a specific piece of information. For example, the user
could request just the information of clients in one particular location.
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Figure 3-16. A spreadsheet contains data arranged in rows and columns.
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Most businesses also use database software to track their employees and
related data, such as address, job title, salary, and certifications. Schools
use database software to track information about students, including
courses, grades, and attendance.

The most common database software includes Microsoft Access, SQL
Server, MySQL, and Oracle. The native file format for Microsoft Access
databases is the ACCDB format.

Presentations

Presentation software provides tools to combine text, photographs,
clip art, video, and graphs into a series of slides for playback. A
presentation allows a speaker to visually enhance the topic of the speech.
Enhancing the experience of the audience can make the event more
memorable. Slide shows are used extensively in classroom lectures,
business presentations, company meetings, sales events, and conferences.

Presentations, or slide shows, are normally projected onto a large
screen for viewing by a group of people. Sometimes presentations are
intended for individual viewing on a computer screen. Often, a slide
show presented to a group is later posted to the Internet for individual
viewing.

Presentation software includes tools to add transitions between
slides. The elements on each slide can be animated to add movement.
Speaker notes can also be included to help the presenter.

Common presentation software includes Microsoft PowerPoint,
Google Slides, and Zoho Show. Google Slides and Zoho Show are cloud-
based solutions. LibreOffice Impress is an open-source alternative. The
native file format for Microsoft PowerPoint data is the PPTx format. The
native file format for LibreOffice Impress is the ODP format.

HANDS-ON EXAMPLE 3.3.2
OFFICE SUITE SOFTWARE

The programs in the Microsoft Office suite of software share a similar interface. It is common for

the software in a suite to have similar functions in similar locations.
1. Close any open applications.
2. Open Microsoft Word, and start a blank document.
3. Open Microsoft Excel, and start a blank workbook.
4. Open Microsoft PowerPoint, and start a blank presentation.
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HANDS-ON EXAMPLE 3-2-2 (CONTINUED)

as shown.

Home tab.

Computing
Fundamentals

3.3.7

All digital photographs
and scanned images are
raster images.

5. Right-click on the Windows taskbar, and click Show windows stacked in the shortcut menu,

K TO ADD TmEé

Toolbars ¥

Cascade windows

[ Showwindowsstacked |

Show windowvs side by Side

Show the desktop
Undo Show all windows stacked

Task Manager

Lock the taskbar

[<]

Properties

Right-click Click

6. List the ribbon tabs that are in all three programs. For example, all three programs have a

7. Click the Home tab in each program.

8. List the group names on the Home tab that are in all three programs. For example, all three
programs have a Clipboard group on the Home tab.

9. Which one group on the Home tab contains the same tools in all three programs?

Graphics

Graphics are pictures, drawings, photographs, and images used as
decoration or to enhance or illustrate a topic. Generally, graphics can
be called artwork. Graphics software is used to create, edit, print, and
distribute the artwork. Professional artists use graphics software as a
primary tool. However, there is graphics software designed for novice
users as well. There are two types of graphics software: raster and vector.

Raster-based software creates graphics composed of dots or
pixels, as shown in Figure 3-17. Each pixel is assigned a specific color
and location. All of the colored pixels are mapped to form the image.
Therefore, a raster image is often called a bitmap. As a raster image is
scaled up or down, there is a loss of quality because the computer must
calculate the changes in color for each pixel.

Raster-based software is used to edit digital photographs and similar
graphics. Artwork created as a raster image may include commercial
logos, advertisements, images for CD covers, and backgrounds for
magazine and book covers. An example of basic raster-based software

Copyright Goodheart-Willcox Co., Inc.
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Figure 3-17. Raster images become pixilated when enlarged, but vector images
can be infinitely scaled without loss of clarity.

is Microsoft Paint, which is included in the Windows OS. Advanced
raster-based software contains tools for adjusting color, brightness, and
contrast; removing red-eye; applying filters for artistic effect; and other
functions. Advanced raster-based software includes Adobe Photoshop,
Corel Painter, Picasa, and GIMP. Picasa is freeware from Google. GIMP is
an open-source alternative.

Vector-based software creates graphics composed of lines, curves,
and fills based on mathematical formulas. Instead of storing the image
definition as a map of colored pixels, each element in the image is
created by its mathematical definition. Since the image is defined by a
mathematical formula, it can be infinitely scaled up or down without loss
of quality.

Vector-based software is used to create line drawings. Artwork
created as line drawings may include diagrams, cartoons, logos, and
floor plans. Vector-based software generally falls into one of two
categories, creating illustrations and drafting. Examples of vector-based
software used to create illustrations include Adobe Illustrator, Corel
Designer, Inkscape, and LibreOffice Draw. Inkscape and LibreOffice
Draw are open-source alternatives. Examples of vector-based software
used for computer-aided drafting and design (CAD) include AutoCAD,
LibreCAD, and SketchUp. LibreCAD is an open-source alternative.

Graphics can be saved in many different file formats. Common
raster file formats include JPEG, TIFF, GIF, and PNG. Common vector file
formats include EPS, Al, SVG, WME, and DXFE.

Copyright Goodheart-Willcox Co.,, Inc.

Chapter 3 Software

115




b

116

Unit 1 Computing Fundamentals

HANDS-ON EXAMPLE 3.3.3
RASTER IMAGE EDITING

Microsoft Paint is basic raster-based software. It contains basic tools for creating and editing
raster images, such as digital photographs.

1. Insert your PRINC-OF-IT flash drive into the computer.

2. Create a folder on the flash drive named Chap03.

3. Navigate to the student companion website at www.g-wlearning.com, download the data files

for this chapter, and save them in the Chap03 folder on your flash drive.

4. In Windows 8, click the Apps button, followed by Paint in the Windows

Accessories category. In Windows 7, click the Start menu button, followed by All
Programs>Accessories>Paint. Microsoft Paint is launched.

5. In Windows 8, click the File tab followed by Open. In Windows 7, click the Paint button to
the left of the Home tab, and click Open in the menu. A standard Windows open dialog box
is displayed.

Navigate to your working folder where the data files for this class were downloaded.
7. Select the Moorhen.tif image file, and click the Open button. The photograph is opened in

Paint.

8. Maximize the Paint window by clicking the Maximize button. This button is located in the

upper-right corner of the window to the left of the Close button (X).

9. Click the View tab, and then click the Zoom out button. The display size of the image is
reduced, but the actual size of the image is unchanged.
10. Click the Home tab, and then click Rotate button. A drop-down menu is displayed.
11. Click Rotate right 90° in the drop-down menu. The image is rotated 90 degrees clockwise, as
shown.

o

Click to display
the menu

o+ L=} T3 1000 = Mg S Sae 418 00 (T4
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HANDS-ON EXAMPLE 3.3.3 (CONTINUED)

12. Experiment with other features of Paint.
13. Click the Close button (X). When prompted to save changes, click the Don’t Save button.

Digital Audio

Digital-audio software is used to create and edit music, narration, and
other sounds in digital format. The resulting audio files can be played on
computers, portable music players, or entertainment centers or added to
videos or web pages. Podcasting is another use for digital audio. Podcasting
is the distribution of audio files, such as episodes of radio or music
broadcasts, over the Internet via automated or subscribed downloads.

Software for composing music includes MAGIX Music Maker, Apple
GarageBand, and LMMS. LMMS is an open-source alternative. These
programs have instruments built into the software. They can also edit
the audio. Audio-editing software includes Sony ACID Pro, Sony Sound
Forge, and Audacity. Audacity is an open-source alternative.

Two common audio file formats are waveform audio file (WAV)
and MP3. The WAV format is the primary format used in Windows
for uncompressed audio. The MP3 format is highly compressed. This
allows the size of recordings to be reduced. For example, if a CD holds
10 uncompressed songs, it may be able to hold over 100 of those songs if
they are compressed in the MP3 format.

Videos

Video software is used to create, edit, and publish digital video
recordings. Using this software, titles, animation, audio, and effects can be
added to video recordings. Additionally, the video itself can be trimmed
and spliced to remove unwanted footage. Many video-editing programs
use drag-and-drop techniques that make it possible to create professional-
looking products with little training.

The equipment necessary to create digital video recordings is small,
light, and portable. It uses built-in hard drives, flash drives, or DVDs to
record many hours of video. Digital camcorders are available in a range
of prices and features. Smartphones can also be used to record video,
typically at a lower quality than a digital camcorder can create.

Several programs are available, from ones that offer full-scale special
effects to more moderately priced options. Adobe After Effects, Apple
Final Cut Pro, Apple iMovie, Microsoft Live Movie Maker, and Avidemux
are examples of full-feature video software. Avidemux is an open-source
alternative.

Entertainment and Educational Software

- Some application software is designed for entertainment and
educational purposes. This software is not used to create an end product,
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like productivity software does. Rather the software is used for the joy of
using it or to learn new information.

Entertainment

Computing
Fundamentals

3.3.6

I - = IEN|
| 2

Car Sounds

Figure 3-18. Windows Media Player is an example of
entertainment software. It can be used to play music,
sound files, or videos.

Education

Entertainment software provides amusement to the person using
it. This software may be a video game, allow the user to watch movies

or listen to music, or simulate a realistic
environment, as shown in Figure 3-18. Video
games are perhaps the most popular type of
entertainment software.

Video games have evolved into many
different categories, including simulations, action,
puzzles, and sports, among others. Multiplayer
games make it possible for two or more players
to participate in the same game. Online games
use the Internet to allow players to participate
and communicate while they play from different
locations. Video games can create virtual realities
that are sophisticated, artificial environments,
which in turn create realistic experiences for the
players.

Entertainment software often requires a fast
CPU, a high-powered video card, a significant
amount of RAM, and a large hard disk. Some
digital games require unique hardware that is
sold with the software, such as a controller in the
shape of a musical instrument. Internet-based
entertainment software often requires a high-
speed Internet connection.

Educational software teaches the user a new skill or provides new
knowledge. This software may teach users how to type, speak a foreign
language, or play a musical instrument.

Personal computers and the Internet provide an opportunity for
mass education. Taking classes online is becoming more popular. Online
courses allow students to attend a class when it is convenient for them
and eliminates having to travel to a physical site.

Simulation programs allow users to practice skills in a virtual
environment instead of a real-world environment. This is a benefit since
users can experience a potentially hazardous environment without
suffering the consequences of a mistake. Examples include simulating
landing a helicopter, piloting a ship into a narrow harbor, using surgical
instruments, and performing a complex machine operation.

Simple tutorial programs can teach users how to use new software.
There are also tutorial programs for preparing students for national
exams, such as SAT, ACT, MCAT, LSAT, GRE, and GMAT.
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Application Utility Software

A certain number of small application utilities are supplied with
the Windows operating system. They include a calculator, a clock and
calendar, a basic text editor, and others. The calculator and notepad are
located in Windows Accessories group of the Apps menu in Windows 8 or
the Accessories folder in the Start menu in Windows 7. Other programs
are accessed through the system tray. The system tray, or systray, is
located on the right-hand side of the taskbar. The clock and calendar and
speaker volume control are located in the systray.

Development Software

Development software is a program used to create new software
programs. Software programs are written in a high-level language and
then compiled into machine language. An integrated development
environment (IDE) provides editing capability to write and correct
program codes, compilers to convert the code into machine language,
and linkers to make executable files. An IDE may contain a software
development kit (SDK), library of code snippets, toolkit, application
programming interface (API), and overall framework.

Microsoft Visual Studio (VS) is one such IDE. VS supports
programming in a variety of languages and generates executable
programs for Microsoft systems. Game engines are another example of
IDEs. These programs provide the tools needed to design and implement
video games. Unity and Multimedia Fusion are just two examples of the
dozens of game engines that are IDEs.

Installing Software z The Garmes Factory 2 nstal Program = = IEM
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When a user chooses what software to
use, the software program must be placed on
the system. This is called installing the software
or setup. The process for installing software is
created by the programmers who developed the
software. Simple applications might just require
copying the program files to the hard drive. More
complex software generally requires an advanced
procedure that modifies the operating system, as
shown in Figure 3-19.

Install program.

hard drive.

no other Windows programs are running.

ctherwise click ‘Next' to cortinue.

Welcome to the The Games Factory 2

This program allovws you to install The Games Factory 2 on your

You must have administrator rights to install this program.

It Is strongly recommendad that before proceeding, you ensure thet

If you do not wish to install The Games Factory 2, click 'Exft' now,

Before attempting to install software, the user ]

Ext |

should verify that the software and the computer L e —

are compatible. This means checking that the
software is made for the installed operating
system and that there is enough space to install
the program files. Each software program
should list the system requirements, which are
specifications for the processor speed, RAM, hard drive space, and any
additional hardware or software needed to run the software.
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Figure 3-19. Most programs have an installer that is
used to properly set up the software on the computer.
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New Installation

Computing
Fundamentals

dictated by Microsoft. This procedure performs several steps:

3.1.1 e determine if the software already exists

e look for enough space to install

® copy the program files onto the disk

® set up data files and folders

e create shortcuts to the program in the Apps or Start menu and

For Windows-compatible products, a standard setup procedure is
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HANDS-ON EXAMPLE 3.3.4 (conTINUED)

3. Click System properties in the ribbon or on the menu bar. Windows Explorer displays basic
information about the computer in the right-hand pane, as shown.

] ; Systen BT - |

+ GorarciPane| + Systern and Security + Syster % € SerchCanbotfarsl 3

ialormation about your computer

Information
|~ about the
computer

If you are unsure of
what features to install,
it is generally safe

to accept the default
settings.

optionally on the taskbar or desktop

® enter a file association for each file type that is created by the new

program
Some installation utilities offer options for the advanced user. For
example, a software program may allow a full or partial installation. A
full installation would consist of all files required for the program to work
plus other files such as samples or a library. A partial installation consists
of only the files required for the program to work. In some cases, a partial

installation will allow the user to select some of the additional files to be
installed.

HANDS-ON EXAMPLE 3.3.4

SYSTEM REQUIREMENTS

Memory and storage specifications are two common system requirements. In Windows, it is
easy to find out how much memory and storage exist on the system.

1. In Windows 8, click the Apps button, and click This PC in the Windows System group.
In Windows 7, click the Start menu button, and click Computer in the right-hand pane.
Windows Explorer is launched with the computer selected.

2. Scroll down until the local hard drive (C:) is visible in the right-hand pane, as shown. Write
down the amount of free space reported. This is the amount of space available for software
installation, although never allow a hard drive to be completely full.

i This PC
B ' =h ﬂ B v T v eraeng:
1ok - b= =4 - 1 System properties
| Properties Open Reriome Access Map network Add a neteiork Open Control =4
media ™ drive = iocation Panel & Manage .
et Neswen sy Available space

] oy ThisPC 1
] -~ ~ 4 Devices and drives (2)

. Favorites

B Desktop s Windewsa(Cy . _#

N D e T T T
%, Recent places

ol
I OVD R Deive (D7)
This o ==
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4. In the Windows section of the information, determine the operating system. Record this

information.

5. In the System section of the information, determine the amount of memory installed. Record this

information.

6. Go to a store, either online or a physical store, that sells software. Select a program that interests
you. Determine if your computer system meets the operating system, memory, and storage

system requirements of the software.

Updates

Updates, sometimes called patches or service packs, are fixes to the
software to correct bugs, remove security issues, or otherwise improve
a version of a software program. When a software update becomes
available, it is a good idea to apply it.

Microsoft automatically handles updates on its operating systems.
Part of the shutdown process involves connecting with the Microsoft

website to see if any updates need to be loaded. If an update is available,

the system will automatically download and install it. Microsoft will
report to the user how many updates are being applied as well as the

progress of the installation. In some cases, an update requires the system

to be restarted to activate the upgrade.

Some PCs are rarely turned off. In this case, Windows can be

configured to automatically install updates without a shutdown. It is

common in business and school settings for computers to remain on

overnight so that updates can be installed without interrupting work.
Most software will have updates throughout the life of a version. If

the software is registered, the developer will generally send a notification
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The computer should
not be turned off until
the update procedure is
complete.
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3.1.3

when a new update is available. Many software programs automatically
check for updates whenever the computer is connected to the Internet.

Uninstallation

A software program should be removed when it is no longer needed
or seems to be causing a problem on a system. The process of removing
software is called uninstallation. Often, this is referred to as performing an
uninstall.

When a program is installed, many files are copied to the hard drive,
often in many locations. Many installations also alter the operating
system. The proper way to remove software is to use the uninstall option
that came with the software. Running this option will remove all of the
files that were installed, reverse any alterations to the OS, and remove
shortcuts to the program. If an uninstall feature is not included with
the software, use the Add or Remove Programs function in the Windows
Control Panel to remove the program, as shown in Figure 3-20.

Reinstallation

Reinstallation is the process of reloading a software program on the
computer system, usually in the same location as an existing installation
of that software. Reinstallation, often called performing a reinstall, is

/Click to uninstall

II?\

&

Control Panel Home

View installed updates

Turn Windows features on or
off

Install a program from the
netwark

= 4 & ¢ Control Panel » Programs * Prngl-—amsa d Features v & Search Programs and Features 0 |

Pragrams agid Features -~ =

Uninstall or chang# a program

Select a program

To uninstall a progra to uninstall

, select it from the list and then click Uninstall, Change, or Repair,

Organize ¥ Uninstall

AA i TE

Adobe Flash Adobe Flash  Adobe Help Adobe Media  Adobe
Player 10,  Player10,,  Manager Player Widg.. | Chrome Sitefdvisar

Mg E 5§D 5

Microsoft  Microsoft  Microsoft  Microsaft  Microsoft  Microsoft  Microsoft |

Access 2013 Office Fi.,  Office S, Visual C++ ., Visual C++ ., Visual C++ ., Wisual C++ .. |
————————— = = | e
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Microsoft  Microsoft  Microsoft  Microsoft MNWIDIA, NVID &
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Figure 3-20. Windows contains a utility that is used to remove installed programs from the computer.
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usually done to reset an installed program to its defaults or to fix the

rogram if it has become corrupted.

To reinstall software, take the same steps as installing new software.
Follow the installation program wizard. Many installation programs will
detect if the software is already installed and give the user the option to
repair or fully reinstall the software. In some cases, the software cannot be
reinstalled unless the previous version has been removed. The installation
wizard should step through whatever process is needed to reinstall or

repair the software. _

[ SECTION REVIEW

]

I’_’? CHECK YOUR UNDERSTANDING

1. What is the name given to the permission to use
a software program?

2. What does the file format indicate?

3. Describe the difference between raster and
vector graphics.

4. What should be listed in the system requirements
for software?

5. Describe the purpose of a patch or service pack.

Copyright Goodheart-Willcox Co,, Inc.

IC3 CERTIFICATION PRACTICE
The following question is a sample of the type of
guestions presented on the IC3 exam.

1. Determine whether each feature is a function of
the OS or the application software.

Restart system

Format a document

Communicate with the peripheral
devices

Install or Uninstall a program

Start a program

® BUILD YOUR VOCABULARY

As you progress through this course, develop a
personal IT glossary. This will help you build your
vocabulary and prepare you for a career. Write a

definition for each of the following terms and add it to -

your [T glossary.

application software open-source software

bugs podcasting

desktop publishing (DTP) proprietary software

end user license raster-based software
agreement (EULA) shareware

file format system requirements
for-purchase software template
freeware vector-based software

integrated development
environment (IDE)



Chapter Summary

Section 3.1
Language of Computers

¢ Communication inside a computer is
conducted through a series of on-off
signals. These signals are electrical in an
electronic computer and represent either
lor0.

® There are various number systems in

the world. Computers are based on the
binary and hexadecimal systems.

¢ Code is computer-readable instructions.
Programs are compiled to create
computer-readable code.

i Section 3.2
System Software

® The operating system performs
communication with the user and the
hardware. There are several different
operating systems supporting several
platforms.

® System utility programs assist in
managing and optimizing a computer’s
performance. These programs may
provide security, assistance, or
communication, among other things.

® Device drivers provide instructions to the

operating system for particular hardware.

Device drivers are used to simplify the
process of creating compatible hardware
and software.

® Programs are what you use to get the job
done. Programs may allow you to create
and edit documents, play music, create
images, and many other tasks.

Section 3.3
Application Software

® The software license specifies how the
software may be legally used. Versions
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of software are created to correct bugs or
offer new features.

Application software allows the user

to perform specific activities. The
software may be related to productivity,
entertainment, education, or other tasks.
Software must be installed in order for
it to be used. Once installed, software

may need to be updated, uninstalled, or
reinstalled.

Now that you have finished
this chapter, see what you
know about information
technology by scanning
the QR code to take the
chapter posttest. If you do
not have a smartphone,
visit www.g-wlearning.com.

Chapter 3 Test

Multiple Choice

Select the best response.

1. Programs written in a high-level lan-

guage are always:

A. interpreted at run-time.

B. readable by the CPU.

C. translated into machine language.
D. linked for all computers.

. The value 3.1415926 would belong to

which data type?
A. integer

B. floating point
C. string

D. date
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Languages are used in computer pro-

gramming to:

A. speak with a computer.

B. write computer instructions at a hu-
man level.

C. segment the hard drive.

D. communicate with the hardware.

Small files that facilitate the operating

system’s communication with peripher-

alsare __

A. utilities

B. boot procedures

C. help files

D. device drivers

Open source software is characterized

by:

A. proprietary copyright.

B. free distribution of derivative
applications.

C. publicly available programming
development files.

D. costly software updates.

Completion

Complete the following sentences with the
correct word(s).

6.

10.

Decimal, binary, and hexadecimal are
examplesof .

Object-oriented programming languag-
es are known as ____ -level languages.
The ___ performs communication with
the hardware.

: software has no licensing

restrictions.

supports the completion of
tasks, such as creating documents or
spreadsheets.
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Matching

Match the correct term with its definition.

13.

14.

15.

base-16 arithmetic
data type
operating system
device driver

proprietary software

Hexadecimal notation.

Manages the activities on a computer
such as communicating with the hard-
ware and running the software.
Cannot be sold, copied, or modified by
the user without permission from the
creator.

Description of values or information
that can be accepted.

Used by OS to communicate with
hardware.

Application and Extension
of Knowledge

1.

Research the history of the Hindu-Arabic
numeral system. Write a one-page paper
describing the origin of this system and
its spread throughout the world.

Identify five computer programming
languages. Classify each as a high- or
low-level language. Prepare for a class
discussion explaining why you classi-
fied each as you did.

Use the search function in the Windows
Start screen or menu to search for
resmon. This is the Resource Monitor
utility. Launch it. Click the Overview tab
in the Resource Monitor. Examine what
information is displayed in the graphs
on the right. Identify the percentage of
CPU usage. Speculate how this utility
can help examine the performance of the
computer system.
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REVIEW AND ASSESSMENT

4. Write a one-page paper that compares
and contrasts the various types of soft-
ware licenses. Provide examples of soft-
ware available for each type of license.
Speculate why a business may consider
each type of license when obtaining
software.

5. Identify three application software pro-
grams on your computer. Compare and
contrast their functions and why you
use them. Prepare for a class discussion
on the importance of application soft-
ware to your daily life.

Online Activities

Complete the following activities, which will
help you learn, practice, and expand your
knowledge and skills.

|Z,* Certification Practice. Complete the
certification practice test for this chapter.

Lj» Vocabulary. Practice vocabulary for this
chapter using the e-flash cards, matching
activity, and vocabulary game until you are
able to recognize their meanings.

Communication Skills

Speaking. Most people in the
United States act as responsible
@® and contributing citizens. How
can a person demonstrate
social and ethical responsibility
College in a digital society? Can you
and Career  think of ways that are not
Readiness jiscussed in this chapter?

Unit 1 Computing Fundamentals

Listening. Passive listening is casually
listening to someone speak. Passive
listening is appropriate when you do not
have to interact with the speaker. Listen
to a classmate as he or she is having a
conversation with you. Focus attention
on the message. Ask for clarification for
anything that you do not understand.
Provide verbal and nonverbal feedback
while the person is talking.

Writing. Generate your own ideas
relevant to using digital technology in

the appropriate manner. Use multiple
authoritative print and digital sources and
document each. Write several paragraphs
about your findings to demonstrate your
understanding of digital citizenship.

Internet Research

Personal Information Management (PIM).
Research personal information management
(PIM) applications using various Internet
resources. Identify a system that would
work for you. Explain how you can apply a
PIM system to your daily schedule.

Teamwork

Working with your team, research
e-mail software. Make a chart showing at
least five options, the system requirements,
and the cost to purchase. One of the software
options should be freeware. Write a memo
to your supervisor (your teacher) listing
the options and recommending an e-mail
software program.
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Portfolio Development

Hard Copy Organization.
As you collect material for
@ your portfolio, you will need

an effective strategy to keep

the items clean, safe, and
College organized for assembly at the
and Career  appropriate time. Structure
fteadiness. 4 organization are important
when working on an on-going project that
includes multiple pieces. A large manila
envelope works well to keep hard copies of
documents, photos, awards, and other items.
A three-ring binder with sleeves is another
good way to store your materials.

Plan to keep similar items together and label
the categories. For example, store sample
documents that illustrate your writing or
technology skills together. Use notes clipped
to the documents to identify each item and
state why it is included in the portfolio. For
example, a note might say, “Newsletter that
illustrates desktop publishing skills.”

1. Select a method for storing hard copy
items you will be collecting.

2. Create a master document to use as
a tracking tool for the components of
your portfolio. You may list each docu-
ment alphabetically, by category, date,
or other convention that helps you keep
track of each document that you are
including.

3. Record the name of each item and the
date that you stored it.
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CTSOs
Objective Test. Some
EV iri competitive events for

PR CTSOs require that entrants
complete an objective

component of the event. This event will
typically be an objective test that includes
terminology and concepts related to a
selected subject area. Participants are usually
allowed one hour to complete the objective
test component of the event. The Global
Business event may also include a team
activity, case, or role play. To prepare for
an objective test, complete the following
activities. '

1. Read the guidelines provided by your
organization.

2. Visit the organization’s website and
look for objective tests that were used in
previous years. Many organizations post
these tests for students to use as practice
for future competitions.

3. Look for the evaluation criteria or rubric
for the event. This will help you deter-
mine what the judge will be looking for
in your presentation.

4. Create flash cards for each vocabulary
term with its definition on the other
side. Ask a friend to use these cards to
review with you.

5. Ask your instructor to give you prac-
tice tests for this chapter of the text that
would prepare you for the subject area
of the event. It is important that you are
familiar with answering multiple choice
and true/false questions. Have someone
time you as you take a practice test.
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